
                                                         
Read Me

Pro Tools TDM 6.9 on Windows XP

This Read Me documents compatibility details, known issues, and guide addenda for Pro Tools TDM 6.9 systems on Win-
dows.

Windows Configuration

Disable Data Executive Prevention (DEP)

When using Pro Tools, Data Execute Prevention should be disabled to prevent system crashes.

To disable Data Executive Prevention: (DEP)

1  Choose Start > Control Panel.

2  Launch System.

3  Click the Advanced tab.

4  From the Startup and Recovery section, click Settings.

5  Click on the down arrow in the Default Operating System pop-up menu, and note if the “/NoExecute=” line reads as fol -
lows:

/NoExecute=Alwaysoff

6  Do one of the following:

• If the “/NoExecute=” reads “/NoExecute=Alwaysoff,” data prevention is disabled, and you do not need to change any 
settings. Click OK to close the Startup and Recovery dialog, click OK to close the Systems Property dialog, and skip the 
following steps.

– or –

• If the “/No Execute=” does not read “/NoExecute=Alwaysoff” (for example, it reads “NoExecuteOptIn”), continue with 
the following steps.

7  Click Edit to edit the startup options file manually

8  Change the “/NoExecute=” line to read as follows:

/NoExecute=Alwaysoff

9  Save the boot.ini file if it was changed.

10  Choose File > Exit.

11  From the Startup and Recovery dialog, click OK.

12  From the System Properties dialog, click OK.
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Compatibility

Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations. 
For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the latest compatibility 
information on the Digidesign Web site (www.digidesign.com).

Installing Pro Tools TDM 6.9 on Windows XP

To ensure proper operation and file management, Pro Tools TDM 6.9 software must be installed by an administrator-level 
user. In addition, to ensure access to all plug-ins from within Pro Tools, the Pro Tools application and all Pro Tools plug-ins 
should be installed and used from the same administrator-level account. 

Disable Automatic Software Update

Digidesign cannot guarantee the compatibility of automatic updates of Windows XP or any updates to system software com-
ponents. For this reason, you should turn off automatic updating in the Automatic Updates tab of the System Control Panel. 
For the latest compatibility information, visit the Digidesign Web site (www.digidesign.com/compato).

Pro Tools Does Not Support Sleep Mode

In the Power Schemes tab of the Power Options Control Panel, set System standby and System Hibernates to Never. Do not 
manually put your computer to sleep when running Pro Tools.

Attaching Pro Tools Legacy Audio Interfaces to Pro Tools|HD I/Os (Item #43380)

Legacy audio interfaces (such as the 888|24 I/O) can power up incorrectly when connected to a Pro Tools|HD audio interface, 
and may not pass audio. This occurs if the Pro Tools|HD card is powered up while the Legacy interface is still in its boot cycle. 
To avoid this problem, turn on Legacy interfaces first, wait until they have completed booting, and then turn on the 
Pro Tools|HD audio interfaces. If you do not notice this state prior to launching Pro Tools, the workaround is to toggle the 
Legacy audio interface in the Hardware Setup dialog.

Known Issues
The following sections document known issues you may encounter when using Pro Tools 6.9, along with workarounds if 
they exist.

Pro Tools

Waveforms Fail to Display During Long Recordings (Item #60719)

When making a long record pass, the waveforms may stop drawing after 20 to 30 minutes. The overviews are calculated after 
the session is re-opened.

Erroneous RAM Limitation Messages (Item #58237)

The Pro Tools Playback Engine can sometimes report that there is not enough RAM for the Number of Voices (per DSP) cho-
sen, even though the system has enough RAM.

Burning CDs with iTunes while Pro Tools Is Running (Item #55192) 

It is possible that Pro Tools will crash when you are simultaneously burning a CD with iTunes. Quit Pro Tools before burning 
CDs with iTunes.

Pro Tools 6.9 Information Is Lost When Saving a Session in an Earlier Version of Pro Tools (Item #49923)

Color coding, Tick-based tracks, and marker comments are lost without warning when a session that is saved in Pro Tools 6.9 
is opened in any earlier version of Pro Tools, or when you save the session in an earlier Pro Tools format using the Save Ses-
sion Copy In command.
Pro Tools TDM 6.9 on Windows XP — 3/31/05 2



                                       
Destructive Processing with AudioSuite Plug-Ins (Item #50454)

Performing destructive file processing with AudioSuite plug-ins while logged into a non-administrative account may cause 
the following error: “Could not complete your request because the system con not find the file specified (2).” 

This is probably because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to 
the audio file. 

If you do not have administrative access of the computer, then you must either contact the administrator of the computer 
to resolve this problem, or use the save copy as feature of Pro Tools, and create a copy of the session with all of its audio files.

Locking Audio Files Within the Workspace Browser While Logged into a Non-Administrative Account (Item #50457)

When Locking your audio files within the workspace window while logged into a non-administrative account may cause the 
following error in the task window of Pro Tools: “Could not complete your request because the system con not find the file 
specified (2).” 

This is probably because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to 
the audio file. 

If you do not have administrative access of the computer, then you must either contact the administrator of the computer 
to resolve this problem, or use the save copy as feature of Pro Tools, and create a copy of the session with all of its audio files.

Opening a Pop-Up Window or Menu Over a QuickTime Movie Crashes Pro Tools (Item #54237)

Opening a pop-up window or menu over a QuickTime video crashes Pro Tools. Keep QuickTime videos out of the way of pop-
ups and menus that you intend to repeatedly open and access.

Mac/PC Compatibility (Item #54395)

On Windows XP, trying to open a Mac session (that was saved with Mac to PC compatibility checked) directly from a HFS+  
drive will result in an error dialog stating that the session must be on an audio record volume. 

In order to mount a Macintosh (HFS+) volume on an XP system using MacDrive or MacOpener and then open a Mac/PC Pro 
Tools compatible session from the drive, you must first copy the session to a local PC drive (it is not necessary to copy over 
the audio files). From the local Windows compatible drive, you can open and run the session.

Bouncing to Disk While Logged into a Non-Administrative Account (Item #50488)

Bouncing to disk to the root level of any SCSI drive while logged into a non-administrative account may cause the following 
error: “Could not complete the bounce to disk command because Access is denied.” This is because Windows XP doesn't al -
low files to be created at Root level of a drive while logged into a non-administrative account. To get around this problem, 
you must create a sub-directory and redirect your session bounce to the newly created directory. 

Recalculating Overviews While Logged into a Non-Administrative Account (Item #50537)

Recalculating overviews of audio files while logged into a Non Administrative account may cause the following error in the 
task window in Pro Tools: “Access denied. (5)”. This is probably caused by the audio files having read-only permissions. 

In order to correct this, you must be able to log into an administrative account in Windows XP and change the permissions 
of the audio file so you have full access to the audio file. 

If you do not have administrative access of the computer, then you must either contact the administrator of the computer 
to resolve this problem, or use the save copy as feature of Pro Tools, and create a copy of the session with all of its audio files.

Performing Commands Which Require Saving a Session on a Non-Administrative Account (Item #53335)

When logged in as non-administrative user, and opening a session which was copied from CD-ROM (or external hard drive) 
onto the system, executing any command which causes Pro Tools to save the session will cause the Access to be denied. To 
resolve this problem, first save the session by Save As or Save Session Copy In.
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Accessing Playback Engine after Opening a Recovered Session (Item #54319)

A recovered session from the Session File Backups folder must first be saved with a new session name before it is possible to 
access the Playback Engine dialog.

Plug-Ins Patch Window with Ram-Based Samplers and Software Synthesizers (Item #53245 and 53314)

Synchronic and other ram–based software instruments make “hiccup” sound when you exit out of the plug-in patch select 
window by pressing “Cancel.” Additionally, the plug-in patches will be forced to re-load the existing sound when previewing 
sounds within plug-in Patch window. 

Song Position Pointer messages are not received in “Continuous Scroll with Playhead” mode (Item #54587)

When in “Continuous Scroll with Playhead” mode, Synchronic, Intakt (Native Instruments) and other MIDI-enabled plug-
ins stop receiving Song Position Pointer messages - they cannot catch up when toggling/priming playback.

Bounce to Movie While Converting Sample Rate Creates White Frames in Quicktime Movies (Item #54220)

While bouncing audio to a Quicktime movie it is not possible to convert the sample rate of the audio during the bounce with-
out compromising the video/audio synchronization. Bounce audio and convert it to the correct sample rate first, and then 
import this audio into another session created at the appropriate sample rate. Import the audio and the movie and then 
bounce to create a new movie.

No Progress Bar While Updating Firmware Using Digitest. (Item #50334)

While updating a peripheral's firmware, the percentage progress is not displayed in the status pane, and the whole dialog will 
display white for a while. When the peripheral has completed its firmware download, the display is re-drawn and again looks 
normal. This is only cosmetic, and does not have any effect on functionality

Launching Large Sessions May Cause Slow Pro Tools Response (Item #45400)

Launching very large sessions with lots of automation and midi tracks causes Pro Tools to go into an unresponsive state for 
up to a minute where the Pro Tools GUI will show large white graphic defects. The application will eventually open success -
fully.

Intermittent Shuttle Lock Commands Ignored (Item #47155)

Shuttle Lock commands occasionally seem to be ignored. Click once on the Transport pop-up and the functionality will re -
turn.

Pro Tools Generates Time Code at Video Reference Frame Rate when SYNC I/O Locked to Video Reference (Item #24219)

When the SYNC I/O clock source is linked to video reference, Pro Tools can only generate time code at the frame rate of the 
video reference. To generate time code at a frame rate other than that of your video reference, set the SYNC I/O Clock Source 
to a non-video reference, or “Internal.”

Pro Tools Fails to Launch Immediately After Booting into Windows (Item #43887)

Attempting to launch Pro Tools before Windows has fully booted (the Windows desktop appears, but system information is 
still being loaded from disk), may result in a quick flash of a white box opening and closing and Pro Tools not launching. 
Launch Pro Tools only after Windows has completely loaded.
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Delay Compensation

Voice Limitations with AFL/PFL Solo and Delay Compensation (Item #58155)

When using AFL/PFL Solo mode and Delay Compensation concurrently, the number of voices will be lowered. For example, 
when running a 7.1 session on an HD Accel 3 system, and Delay Compensation with a Long Delay Compensation is enabled 
and AFL/PFL mode is enabled, only 138 Voices can be allocated under the 192 Voice/6 DSP Engine.

Punch In and Punch Out Offsets and Delay Compensation (Item #54032)

If you enable or disable Delay Compensation, you should re-check your punch in and punch out offsets. Punch offsets need 
to be changed as the delay compensation changes.

Some RTAS Software Synthesizers Incorrectly Report Sample Delays to Pro Tools (Item #54041 and 55050)

RTAS software synthesizers that report sample delay to Pro Tools may cause problems when using Delay Compensation. If 
you are using Delay Compensation, you should Start-Control-click (Windows) or Control-Command-click (Macintosh) on 
the “dly” field of any track that has an RTAS software synthesizer, so that the software synthesizer does not report any sample 
delay to Pro Tools.

Diminished Audio Record and Playback Performance while Using Delay Compensation (Item #46346)

Delay Compensation requires a substantial amount of system resources, especially in large sessions. If you encounter DAE er -
ror –9073 when Delay Compensation is enabled, turn Delay Compensation off to free system resources.

Maximum Track Voices Are Limited by Delay Compensation and High Sample Rates in 5.1 Surround Sessions (Item #46915)

When working on a 192 kHz or 176.4 kHz session, with Delay Compensation turned on, the maximum number of 5.1 sur -
round tracks is 18 on a non-Accel system and 29 on an Accel system, even if your system appears to have free DSP resources 
available.

Milliseconds/Samples Discrepancies (Item #44299)

It is possible to set a User Delay Offset in milliseconds which exceeds the highest setting allowed when converted to samples. 
To avoid this problem, enter User Delay Offset in samples.

Upsampling Pro Tools Sessions (Item #42970)

When upsampling a session (using Save Session Copy In), values for delay compensation and user offset in the newly created 
session may exceed the system limitations. 

Plug-Ins

Synchronic Samples Not Loaded after Opening a Session (Item #58593)

In certain cases, Synchronic samples are not loaded after opening a session. This is only a problem when the samples loaded 
into Synchronic exceed loops longer than 4 bars in length.

–6074 Error When Toggling All Plug-Ins Between Active and Inactive Mode During Playback (Item #55049)

In large sessions, deactivating and reactivating all the plug-ins can cause Pro Tools to post the following error: “The engine 
DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (-6074).” To resolve the problem, activate and deactivate 
plug-ins in smaller groups.

HTDM (Macintosh) to RTAS (Windows) Cross-Platform Plug-In Incompatibility (Item #52959)

HTDM software synthesizer plugs-ins previously saved on Mac OS X platform will not be recognized: They are converted to 
RTAS plug-ins on Windows XP.
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HTDM Plug-Ins and Distortion (Item #53549)

Distorted sound through HTDM plug-ins can still persist even after changing and matching hardware buffer size and/or using 
larger Stream Manager buffer. Deactivating and reactivating the problematic plug-in may fix the problem.

Pro Tools Posts an Erroneous “The Plug-In Could Not Be Made Active Because It Is Not Preceded by an RTAS Instrument 
Plug-In” Dialog (Item #53606)

This message occurs on sessions created with one Pro Tools configuration, and opened on another. This is because either the 
user does not have the necessary plug-in in the plug-ins folder, or the plug-in version available on the different Pro Tools sys-
tems do not match.

Transferring Sessions with Plug-Ins Between TDM and LE Systems

When transferring sessions between LE and TDM systems, plug-in settings should be copied manually to the session’s Plug-
In Settings folder. This will restore the proper plug-in preset names.

DigiRack Pitch Is Not Phase Coherent When Using Delay Compensation (Item #38771)

The DigiRack Pitch plug-in is not phase-coherent when using TimeAdjuster for delay compensation on the same track.

Plug-Ins Lose MIDI Beat Clock Setting When Opened in Versions of Pro Tools Prior to 6.9 (Item #39604)

Some plug-ins (such as the Digidesign Bruno and Reso plug-ins) automatically receive MIDI Beat Clock in Pro Tools 6.9. If you 
open a session created in Pro Tools 6.9 on a system with an earlier version of Pro Tools, you will need to manually reassign 
MIDI Beat Clock for these plug-ins. 

AudioSuite Signal Generator Does Not Process (Item #35900) 

The AudioSuite Signal Generator plug-in defaults to “Create Individual Files.” If you make a selection in the timeline that 
does not contain audio, you will need to select “Create Continuous File,” or you will encounter a dialog warning you that no 
audio is selected.

RTAS Plug-Ins on TDM Systems

When using RTAS plug-ins on TDM systems, you may encounter DAE –6031 or –9128 errors. In these instances, you can in-
crease the H/W Buffer Size and CPU Limit percentage in the Hardware Setup dialog (refer to the Pro Tools Reference Guide for 
details) to get better system performance. With slower CPUs, you may also need to reduce the number of RTAS plug-ins used 
in the session to get acceptable results.

AudioSuite Processing and Side Chain Inputs

Side chain inputs for plug-ins (such as d3, Compressor, and Limiter) have no effect on AudioSuite processes when the Selec-
tion Reference is set to Region List.

In addition to slower screen redraws and UI responsiveness, larger Hardware Buffer sizes can affect automation accuracy 
for plug-in parameters and mute data, as well as timing for non-time stamped MIDI tracks.
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File and Disk Management

Pro Tools Unable to Relink to Audio Files and Fade Files That Have Illegal Characters when Mac/PC Compatibility Not 
Enabled (Item #60728)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without 
the Enable Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually 
relink each file by File ID.

I/O Setup Files Can Be Saved with Illegal Characters when Mac/PC Compatibility Option Not Enabled (Item #60730)

When importing I/O Setup files (.pio files) from Macintosh sessions that were not saved with the Enable Mac/PC Compati -
bility option enabled, files that have illegal characters are not converted successfully—illegal characters do not get replaced 
with an underscore.

Lost Data when Burning Sessions to DVDr (Item #59227)

When doing a session data backup to a DVDr with the MacDrive6 DVD/CD burning utility, it is possible that session data on 
the DVDr will be lost.

Unable to Open Macintosh Sessions from Workspace if Title’s Illegal Characters Were Converted to Underscore Symbol 
(Item #60243)

You will not be able to open a Macintosh session from the Workspace if the session name contains illegal characters that were 
converted to underscore. The workaround is open the session will File > Open Session.

System Crash on Startup with Macintosh Formatted FireWire Drives (Item #45288)

After installing MacDrive, mount Macintosh formatted FireWire drives only after Windows has finished starting up. Starting 
up with FireWire drives connected after installing MacDrive causes a system crash. 

Disk Management when Using Macintosh Formatted Drives (Item #45459)

User must disable the MacDrive service in order to convert or re-format an HFS+ FireWire drive to NTFS format. 

Loss of Sharing Information when Unmounting Drives from Pro Tools Workspace (Item #46273)

Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is 
unmounted from within a Pro Tools workspace. If you wish to re-mount the drive, go to Control Panel > Administrative 
Tools > Computer Management > Disk Management, find the drive, and re-assign the drive letter.

Files Are Not Linked when Opening a Session Created on Windows XP with a Macintosh (Item #46199)

When bringing a session from Windows to Macintosh using MacDrive or MacOpener, make sure that AIFF extensions of au-
dio files are retained. In MacDrive Properties, enable “Don’t Remove Extensions.” This will ensure session compatibility when 
opening Windows sessions on the Macintosh.

Sluggish Performance when a Mapped Network Drive Becomes Unavailable (Item #44420)

When using Pro Tools, make sure all mapped networks are present and available. If your computer is mapped to a network 
drive that becomes unavailable, Pro Tools may become sluggish. A workaround is to unmap the network drive.
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Control Surfaces

Downloading Firmware for D-Control or D-Command (Items #46015, #46990, #58102)

While downloading firmware updates on D-Control, do not adjust any controls in the main unit’s monitoring section, or 
transfer files on your computer. Doing so may interfere with a successful firmware download.

Motor Firmware Version Display on a Fader Pack (Item #59071)

When pressing the Firmware version button on a Fader Pack while in Utility mode, the displays will read the firmware version 
for Motor twice. There are two fader motor control boards on a Fader Pack, one for the left 8 faders and one for the right. The 
Motor firmware display shows both versions.

MIDI

Software Instruments Keep Playing after Half-Speed Playback Is Stopped (Item #54807)

Occasionally, software instruments keep playing even after playback is stopped. This problem occurs after choosing the half-
speed playback mode. To reset the MIDI notes, open the Playback Engine dialog and immediately click OK to close it, or 
choose MIDI > All Notes Off. 

Plugging or Unplugging a USB MIDI Interface Causes Pro Tools Problems (Item #50136, 48445 and 48446)

Pro Tools does not support hot plugging or unplugging of USB MIDI interfaces. Attach your MIDI interface to your computer 
before launching Pro Tools, and quit Pro Tools before unplugging the MIDI interface.

Pro Tools UI Gets Sluggish While Recording MIDI (Item #52815)

During lengthy MIDI record passes, the Pro Tools user interface can begin to feel sluggish if the MIDI event list is open. Close 
the MIDI Event List window during extended or heavy MIDI record passes.

Only 32 Emulated MIDI Inputs Appear in Pro Tools (Item #53224)

Windows XP has a 32 MIDI port (input or output) limit for Emulated MIDI devices. If you are using devices which are non-
timestamped (Emulated), only the first 32 Emulated inputs and Emulated outputs will appear as selectable in your MIDI ap-
plication.   

MIDI Inputs and Output Seem to be Missing from the Screen, or Appear to Scroll off Screen (Item #53611)

When the screen resolution is set to 1024x768, users with large MIDI configurations might notice MIDI inputs/outputs miss -
ing from the MIDI input/output routing pop-up dialogs. Resize the screen to a higher resolution to resolve this problem.

Latency When Recording MIDI Tracks with Wait for Note and a Virtual Instrument (Item #43068)

When recording a virtual MIDI instrument track in Wait for Note mode, latency occurs at Bar 1|Beat 1.

Synchronization and Machine Control

Colin Broad Controller in Fan-Out Configuration with Colin Broad Controlling a VTR Requires Specific Settings for Consistent 
Lock Times (Item #59796)

Using the Colin Broad in a fan-out configuration where a linear VTR is an active slave requires the following settings to yield 
consistent lock-up times:

1  Make the tape machine the master in the Edit group.

2  Change the Colin Broad setting Menu 21 to “Input lock tally from – Master.”

3  Optimize Pro Tools Machine Control pre-roll setting for your workflow and track count.
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Video

Pro Tools Cannot Record Video (Item #59710)

If a 23.976 or 24p session is changed to 29.97, video cannot be recorded until Pro Tools is closed and relaunched.

Unrecognized Movies in Pro Tools (Item #46792)

QuickTime and DV movies can lose their .mov or .dv suffix in Macintosh OS X. If a Pro Tools session contains a movie that 
has lost its suffix, the movie will not be recognized as a valid file by Pro Tools and cannot be opened. To work around this, 
close the session, manually add the .dv or .mov suffix to the movie and then re-open the session.

The “Machine Cues Intelligently” Preference Should not Be Used with Non-Linear Decks (Item #46200)

Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked 
when using nonlinear playback devices.

Pro Tools Hangs when Playing a QuickTime Movie (Item #44004)

The standard QuickTime install only installs the core QuickTime components. Some QuickTime movies require additional 
components. If you do not have these additional components installed and try to play the movie in Pro Tools, Pro Tools 
hangs. Play the movie in the QuickTime player to determine whether or not all the necessary components are installed. If you 
are missing any necessary QuickTime components, the QuickTime player will prompt you to install them. After installing the 
additional required QuickTime components, you can import and play back the QuickTime movie in Pro Tools.

General Localization 

Region Misnaming in Tracks That Contain Japanese Katakana Characters “So” and “Po” (Item #58140)

On tracks that contain the Japanese katakana characters “So” and “Po” in their names, recorded regions are erroneously 
named with katakana “Da” instead (in the place where there should be a “So” or “Po”).

Pro Tools Asian Version Cannot Launch on English OS (Item #59794)

When your computer OS is set to English, you cannot launch the Japanese, Korean or Simplified Chinese Localized version 
of Pro Tools. Attempting to do so will result in the following message: “To run Japanese version of Pro Tools, the Finder's sys -
tem preferences International settings must be set to Japanese. Please refer to Digidesign's documentation to know more in-
formation.” The workaround is to launch the Asian Localized application and change the languages setting of the Finder to 
the appropriate Asian language.

No Double-Byte Character Entry in Browser When Mac/PC Mode Is Enabled (Item #54387)

You cannot name files with double-byte characters in a browser window if Pro Tools is launched in Mac/PC enforced mode. 
To use double-byte characters, re-launch Pro Tools with Mac/PC mode disabled. 
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Error Messages

Error –6031 During Playback (Item #32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the 
session, quit and re-launch Pro Tools, then re-open the session before resuming playback.

Error –6097 Lost Communication with the 002 Unit

If you encounter a –6093 error, confirm that you have a valid clock source. Or, increase the Hardware Buffer Size or remove 
some plug-ins to use less DAE memory. 

DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks 
to the appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.
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